spines.. Each working area on the layout is considered a label block on the sheet. You can access the un-
accessible labels on your layout with the Next and Previous Block commands from the “Design Menu’”.
Once you have moved to the next block, you can add whatever label design and print them in the same
place as your CD labels.

Printing: Step 8: Sure Thing - CD Stomper Software makes printing on CD
label sheets a breeze. It knows where each label is located on the sheet, and
sequences the labels as they print from sheet to sheet.

Once you have your design ready to print, you may choose the Print com-
mand from the “File Menu”.

The Print Dialog box allows you to specify the number of labels you wish
to print and which label on which to begin printing. Click on the first label on
the sample to choose the first label. You can also click on the “Pages” radio

Printing Requester Box

button if you want to print a number of entire sheets of the same label. The blue labels in the sample depict
the labels which will actually print on the first page of the print job.

Helpful Hints:

1.
2.
3.

Try printing on a plain piece of paper to check quality and alignment.
Set printer to lowest resolution for a quick test print.
Allow ink to dry after printing.

4. When handling discs, do not touch the surface of the disc.

5.
6.
7.

Don't expose the disc to dust, smoke, sunlight, heat, cold or humidity
Never remove label once it has been applied.
Read the full 103-page manual which is discussed on Page 1 of this user guide.

CD LABEL APPLICATION AND USING THE APPLICATOR DEVICE
Once the CD Stomper applicator is removed from the packaging, place it on a flat surface and twist the
small knob sticking out of the top to unlock it and allow the spring action mechanism to work.

1.
2.

3.

To apply your printed label, you must first remove the label from the label stock after it has been printed.
Place the label with the graphics side down, adhesive side up, over the plunger portion of the
CD Stomper Applicator.
Take the CD you wish to label and place it on the small knob that is on top of the plunger.
Remember to place it data side up.

. Using three fingers, grab the knob so that the tips of your fingers come in contact with the CD. Now,

push down on the spring loaded plunger so the CD comes into contact with the label. You may now lift
back up on the plunger and your CD has just been “Stomped”.

. Itis a good idea to rub the label down onto the CD to remove unwanted air bubbles and to permanently

affix the label to the CD. The bottom rubber side of the Stomper is a good place to place the CD to
perform this final step.

el Llad

Contacting Stomp Inc.,
Stomp Inc., 2950 Airway Ave., Suite B1, Costa Mesa, CA. 92626. Phone: (949) 250-6771, Fax: (949) 250-6775.

D Stomper Quick Stat Guid

INTRODUCTION: For VVanOWS

Welcome to Sure Thing - CD Stomper Software, the easiest way to create, and printlabels
for all your CD needs. Combine the Sure Thing - CD Stomper Software with your CD Stomper CD
Labels and Jewel Case Inserts, and you've got a total CD labeling solution.

MANUALS AND DOCUMENTATION (Please Read):

This Quick Start Guide is included to aid you in the basics of our software program. We
strongly encourage you to access, print and read the 103-page comprehensive manual which is in-
cluded on your CD.

Once the software is installed, Win95/98/NT4.0 users can access this manual in two ways,
tyou may find the manual by accessing the CD itself from the “MY COMPUTER” Icon, and the man-
ual will be in the root directory. The second way is selecting the “Start” Button on the desktop. Go to
“Programs”; then selecting the “CD Stomper-Microvision” group and the manual will be there.

Once the software is installed, Win3.x/NT3.5x the manual can be found by going to your
“Program Manager” and it will be inside the CDStomper-Microvision Program Group.

Attention all users - The manual provided is in an Adobe Acrobat .PDF format. If you
have Acrobat already installed, the manual will come up immediately. If you do not have Acrobat in-
stalled, we have provided this program for you to install. Please see section on Adobe Acrobat.

ACCESSING THE OVER 1200 PRE-DESIGNED BACKGROUNDS AND CLIPART

The software has come with 750 pieces of pre-designed backgrounds for your CD Labels
and Jewel Case Inserts which we hope you will love. The program has an additional 500 pieces of
clip art. We have created an Adobe Acrobat .PDF of all the backgrounds so you can browse and print
them all at a glance. This will be helpful for you to choose and know the file name of the Image you
like when you are ready to insert it into your design. The file for the CD Backgrounds Catalog is
called CD_ART.PDF.

Win95/98/NT4.0 users can access this file in two ways. The first is by accessing the CD
itself from the “MY COMPUTER” Icon, and the CD_ART.PDF. file will be in the folder called Stomp35.
The second way is by selecting the “Start” button on the desktop. Go to “Programs”; then selecting
the “CD Stomper-Microvision” you will find the file in the CD_ ART Group .

Win3.x/NT3.5x users will find the file CD_ART.PDF by going to the “Program Manager”;
the file will be found inside the CDStomper-Microvision Program Group.

USING ADOBE ACROBAT TO VIEW THE ARTWORK AND MANUAL

The manual and the CD-ART .PDF catalog are both viewable and printable in Adobe Acro-
bat. If Adobe Acrobat is already installed on your system, please ignore this section. If it is not al-
ready installed, follow the following instructions to install it so you can access the Manual and the
CD_Art Catalog.

Win95/98/NT4.0 Users - You can install Adobe Acrobat reader by finding the installer on
the CD Stomper CD. You will first find the CD Stomper CD itself by selecting the “MY COMPUTER”
icon. Once you choose the CD Stomper35 CD, you will then find a folder called (ADOBE). In this
folder you will select the folder named Reader95. Once this folder is open a file named Ar32e301.exe
will come up. Double click on this file to install Adobe Acrobat onto your System.



Win3.x/NT3.5x Users - You can install Adobe Acrobat reader by finding the installer on the CD
Stomper CD. You will first find the CD Stomper CD itself by selecting from the “Program Manager” the
“RUN” option from the “File Menu”. To choose your CD Stomper CD you must click on the “Browse” button
and select the CD-Rom drive where your CD Stomper CD is located. Once you have located your CD
Stomper CD, you will then find a folder called (ADOBE). In this folder you will select the folder named
Reader31. Once this folder is open, a file named Ar16e301.exe will come up. Double click on this file to
install Adobe Acrobat onto your System.

STEP-BY-STEP INSTALLATION AND INSTRUCTION

Installing: Step 1: Windows 95/98/NT4.x customers, please place the CD Stomper
= Pro CD Version 3.5 into your CD ROM Drive. Go to the “MY COMPUTER” icon lo-
%- ﬂ cated on your desktop and double click on it. Once you are in the “MY COMPUTER”
v === | iCON, double click on the drive letter that represents your CD Stomper CD. The setup/

- Install procedure should automatically run. Please read and follow the setup prompts.
Opening Setup Screen For Windows 3.x/NT3.5x customers please go to your “PROGRAM MANAGER”. Se-
lect the “Run” option and type in the command line: d:\install (where d:\ is your CD
ROM letter); then click on “OK” . Please read
and follow the setup prompts.
Running The Program: Step 2: The CD Stom-
per install will create a program group within
your “START" menu bar called “CDStomper -
Microvision”. This group contains an icon
called “Sure Thing CD Labeler”. Please select this icon to run the application.
Selecting the Right Label Stock Step 3: The Sure Thing - CD Stomper Soft-
ware supports multiple layouts for both CD labels and your jewel case inserts in
both US letter and A4 paper sizes. In order to choose the correct label stock ,
you must click on the “FILE” menu item; then select “NEW”. It will bring up a
dialog Box. Once this box is up, please select the correct template you desire.
US Customers need to select “Pro CD Labels 2-up” or “Jewel Case Inserts (US)".
International customer using A4 paper need to select “Pro CD Labels 2-up (A4)"
[R— or “Jewel Case Inserts (A4)".
The Layout Options Step 4: If you would like to view
the entire template, you can do so by going to the menu .=-':'-=-EI
bar at the top of the screen and clicking on the “VIEW” menu and then selecting the | =~
“FULL PAGE" option. You will now have both circular labels and other working areas @
on your screen. You can go back to the single design view by repeating the process.
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Selecting Template

View Drop Down Menu

Placing Graphical Images Step 5: Sure Thing - CD Stomper Software sup-
ports a number of different image formats which can be placed on a design. These formats are JPEG, TIFF,
EPS, BMP, PCX and WMF. Also, don't forget the over 1200 pre-designed images which are already on your
software.
To insert a graphical image for your CD Label or Jewel Case Insert, follow these steps: 1. Under the “File”
menu you will find a row of icons. One of the icons looks like a mountain. This is
labeled the “PICTURE TOOL”, and this can be seen to the left. Click on
this Icon, and it will turn your cursor into this mountain icon . 2. Now,
move the cursor back down to the area on the template you want the
""" image placed and click; then drag to create a box inside the CD outline
on the template where the image will go. 3. Release the mouse button. 4, A
dialoge box named “New Picture” will come up. In the “Look in” field of the “New
Picture” dialoge box you will need to go find the path to the graphic that you want
to insert. 5. Once you've shown the software the path to the images , double click

Inserting CD_Art Image

on that image file name and your graphic will be inserted. 2

Example of Inserting one of the pre-designed backgrounds included on your CD.

Once you have selected the picture tool and drawn a box on your template the “New Picturw”
dialogue box will come up. From the “Look In” field please locate the CD ROM drive which represents the
CD Stomper CD. Inside the CD you will go to a folder named Stomp35. Now you will select the folder titled
CD_ART.

Within this folder are eight more folders which contain all the pre-designed background images,
(remember, you can view all the pre-designed images with Adobe Acrobat). For purposes of this example,
select the “Picture Folder” and then select pict15.jpg. This will automatically bring Pict15.jpg into the box
you created earlier.

Re-Sizing your Image Step 6: Now that you have the graphic on the template, you must re-size

(or make it bigger) it to cover the entire CD Label.

Using the pointer tool (shown to the left), move this image to the far upper left corner of the CD template.
Do this by clicking and holding the pointer tool down any-
where on the selected image; then push the mouse up and to

h the left. After moving the image to the top left corner you will

Pointer . Want to resize the image by moving the pointer tool to the

™' Jower right corner of the square. Then you will click, hold and
grab the bottom right corner of the red square and drag it to the lower
right part of the template. Then just let go and the CD graphic image will ==
then resize to perfectly cover the entire CD. You can follow these steps to resize any image.

Creating Text  Step 7: Before creating text you must know how to move
objects to different layers within your template. The Stomper software works
in layers. What that means is you can have a graphic layer and a text layer
D overlapping on top of one another. If the graphic layer is in front of the text
layer, you will not see your text. To move objects to front or back layers,
you will first select an object by clicking on it with the pointer tool; then select
the “EDIT MENU"™ on your tool bar. Here you will find the options for moving
objects to the front or to the back of the layers.
There are two distinctly different tools for adding text . Both tools work differently.
The first text tool is the Text Frame tool: This tool is pictured to the left and can be
El found on the tool bar. Once you select this tool, you will follow the procedures we have de-
eaerame  SCribed before to draw a box (in this case a Text Box) in the area of the template you want to
place your text. Once you have drawn the box and released your mouse, the I-Beam tool
:I: pictured to the left will start blinking. You can now start to enter your text. By using the
Text Frame tool to create text you will use the tools on the toolbar to change font, color, size
and alignment of your text.
The second text tool is the Text Effect tool: The Text Effect tool is used to create special text.
Use this tool to create Circular Text, Twisted Text, 3-Dimensional Text, Color Gradiated Text J
RE[

Editing/Entering Text

I-Beam

and much, much more. The Text Effect tool icon is pictured to

= &1 s = | theright and can be found on your tool bar. Again, once you
e —‘-'=| have selected this tool you will need to draw a box where you et
'--I want the text to be placed. Once you have drawn the box and
— = % released the mouse, the words “Your Text Here” will appear in the box you
mr "r * just created . You now need to double click on this box to add, modify and

. add effect to your text. A Text Effect dialog box will now come up. This
dialog box is pictured to the left.. You will work in this Text Effect dialog

box to create your effects, styles, fills, borders and much, much more. Please spend time learning how to

use this tool . It is a powerful function of this software that will make your CD’s look fantastic!!!

ACCESSING THE ALTERNATE AREAS OF YOUR WORKSPACE

Many of the CD Stomper label sheets have additional labels for diskettes, zip disks and jewel case 4

Text Effect Window



